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Land Buy-Back Program for Tribal Nations Outreach Toolkit How-to Guide 

Overview:  The Land Buy-Back Program for Tribal Nations (Program) provides Federal and Tribal staff a 

variety of outreach and information-sharing templates, called the Outreach Toolkit.  Federal and Tribal staff 

can use the Outreach Toolkit as a starting point when developing outreach materials for Program 

implementation at their location.  The toolkit contains templates for event invitations, posters/flyers, letters, 

newspaper ads, Whereabouts Unknown (WAU) ads, radio ads, and instructions for ordering Program 

banners.   

Beginning on page five, this document provides step-by-step instructions for making general changes to the 

documents in the Toolkit.   

The Outreach Toolkit contains the following templates:  

• WAU Ad:  This document provides space for staff to list the names of landowners whose whereabouts 

are unknown.  It asks individuals that are on the list update their Individual Indian Money (IIM) account 

information by calling the Trust Beneficiary Call Center (Call Center) or by visiting their local Bureau of 

Trust Funds Administration (BTFA) agency office.  It also asks individuals who know someone on the 

list to notify that individual.  The list of names for this advertisement would come from the Program’s 

Contract and Tract Spreadsheet (CATS) WAU tab.  The WAU list contained in the Landowner Report 

(LOR) and Mid-Offer Report (MOR) cannot be used, only the CATS WAU list.  The General Tips 

section at the end of this document provides step-by-step instructions for removing the second page if it 

is not needed. 

 

There is space in the top left-hand corner of this template, as well as many of the toolkit items, for inclusion of the Tribal 

seal.  For all uses, please obtain proper authorization prior to use of the Tribal seal.  Some Tribes require Tribal council 

approval prior to use.  If the Tribe authorizes the use of their seal, copy and paste the image into the document and adjust 

the size accordingly.  To remove the note that says “Must receive approval to use crest/seal. If not approved use Buy-Back 

logo”, simply click note, and hit the delete button on the keyboard.  Consult the General Tips section at the end of this 

document for step-by-step instructions on inserting a Tribal seal and deleting the approval note.  The Buy-Back Program 

logo is provided in the template for use in place of the seal if desired or authorization is not obtained.   

 

• Event Invitation:  This document provides space for information about an upcoming outreach event 

including the date, time, location, and agenda for the event.  Staff can include a phone number and/or 

email address for landowners to seek out more information.  

 

There is space in the document for inclusion of the Tribal seal.  For all uses, please obtain proper authorization prior to use 

of the Tribal seal.  Some Tribes require Tribal council approval prior to use.  If the Tribe authorizes the use of their seal, 

copy and paste the image into the document and adjust the size accordingly.  To remove the note that says “Must receive 

approval to use crest/seal. If not approved use Buy-Back logo”, simply click note, and hit the delete button on the keyboard.  

Consult the General Tips section at the end of this document for step-by-step instructions on inserting a Tribal seal and 

deleting the approval note.  The Buy-Back Program logo is provided in the template for use in place of the seal if desired or 

authorization is not obtained.   Included in the event is a stock photo that you are welcome to use. However, if you have a 

more relevant photo, such as one depicting land at the reservation, please feel free to replace the photo.  The General Tips 

section at the end of this document provides step-by-step instructions for replacing the background image of a document. 

 

• Radio Ad Templates:  The radio ad templates offer several pre-offer and post-offer outreach scripts for 

30-second and 60-second advertisements.   
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The pre-offer scripts can be used by Tribes and Federal staff to develop radio ads informing 

landowners of the upcoming Program implementation at their location, briefly summarize the 

Program’s functions, and instructs landowners to update their IIM account information by calling the 

Call Center or visiting their local BTFA agency office.  The script directs landowners to visit the 

Program’s website for more information. 

 

The post offer scripts can be used by Tribes and Federal staff to develop radio ads reminding 

landowners the Program has sent offers, and to restate what happens to their land if they choose to 

sell their interests.  The script directs landowners interested in participating in the Program to return 

their completed offer packages as soon as possible.  The ads provide the contact information for the 

Tribal outreach office if landowners need assistance.   

 

• Letter-Pre Offer:  The pre-offer letter is sent to landowners prior to the Program’s implementation at a 

location.  The letter provides space for general information about the fractionation, the Program, and 

why they have been invited to participate.  The letter also provides space for Federal/Tribal staff to invite 

the recipient to upcoming Program events.   

 

There is space in the top left-hand corner of this template, as well as many of the toolkit items, for inclusion of the Tribal 

seal.  For all uses, please obtain proper authorization prior to use of the Tribal seal.  Some Tribes require Tribal council 

approval prior to use.  If the Tribe authorizes the use of their seal, copy and paste the image into the document and adjust 

the size accordingly.  To remove the note that says “Must receive approval to use crest/seal. “If not approved use Buy-Back 

logo”, simply click note, and hit the delete button on the keyboard.  Consult the General Tips section at the end of this 

document for step-by-step instructions on inserting a Tribal seal and deleting the approval note.  The Buy-Back Program 

logo is provided in the template for use in place of the seal if desired or authorization is not obtained.   

 

• Newspaper Template Pre-Offer General:  This document alerts landowners about the upcoming 

Program implementation at the location where they own land.  The half-page announcement provides 

space for the contact information for the Call Center, the Tribal outreach office, and the local BTFA 

agency office.   

 

There is space in the top left-hand corner of this template, as well as many of the toolkit items, for inclusion of the Tribal 

seal.  For all uses, please obtain proper authorization prior to use of the Tribal seal.  Some Tribes require Tribal council 

approval prior to use.  If the Tribe authorizes the use of their seal, copy and paste the image into the document and adjust 

the size accordingly.  To remove the note that says “Must receive approval to use crest/seal. If not approved use Buy-Back 

logo”, simply click note, and hit the delete button on the keyboard.  Consult the General Tips section at the end of this 

document for step-by-step instructions on inserting a Tribal seal and deleting the approval note.  The Buy-Back Program 

logo is provided in the template for use in place of the seal if desired or authorization is not obtained.  Included in the event is 

a stock photo that you are welcome to use. However, if you have a more relevant photo, such as one depicting land at the 

reservation, please feel free to replace the photo.  The General Tips section at the end of this document provides step-by-step 

instructions for replacing images. 

 

• Newspaper Template Pre-Offer Event Announcement:  This document provides space for 

information about the name, date, time, and location of a pre-offer outreach event.  The half-page 

announcement also provides the Call Center contact information.   

 

There is space in the top left-hand corner of this template, as well as many of the toolkit items, for inclusion of the Tribal 

seal.  For all uses, please obtain proper authorization prior to use of the Tribal seal.  Some Tribes require Tribal council 

approval prior to use.  If the Tribe authorizes the use of their seal, copy and paste the image into the document and adjust 
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the size accordingly.  To remove the note that says “Must receive approval to use crest/seal. If not approved use Buy-Back 

logo”, simply click note, and hit the delete button on the keyboard.  Consult the General Tips section at the end of this 

document for step-by-step instructions on inserting a Tribal seal and deleting the approval note.  The Buy-Back Program 

logo is provided in the template for use in place of the seal if desired or authorization is not obtained.  Included in the event is 

a stock photo that you are welcome to use. However, if you have a more relevant photo, such as one depicting land at the 

reservation, please feel free to replace the photo.  The General Tips section at the end of this document provides step-by-step 

instructions for replacing images. 

 

• Poster-Template Pre-Offer Tribe:  The poster alerts landowners of the upcoming Program 

implementation at the location where they own land.  The document briefly describes what the Program 

is and what happens to land after an owner decides to sell their interests.  Landowners interested in 

participating are directed to ensure their IIM account information is up to date by calling the Call Center 

or by visiting their local BTFA agency office.  The poster directs landowners with questions about the 

Program to visit the Program’s website.  The poster provides space for the phone number, email address, 

and location of the Tribal outreach office.   

 

There is space in the top left-hand corner of this template, as well as many of the toolkit items, for inclusion of the Tribal 

seal.  For all uses, please obtain proper authorization prior to use of the Tribal seal.  Some Tribes require Tribal council 

approval prior to use.  If the Tribe authorizes the use of their seal, copy and paste the image into the document and adjust 

the size accordingly.  To remove the note that says “Must receive approval to use crest/seal. If not approved use Buy-Back 

logo”, simply click note, and hit the delete button on the keyboard.  Consult the General Tips section at the end of this 

document for step-by-step instructions on inserting a Tribal seal and deleting the approval note.  The Buy-Back Program 

logo is provided in the template for use in place of the seal if desired or authorization is not obtained.  Included in the event is 

a stock photo that you are welcome to use. However, if you have a more relevant photo, such as one depicting land at the 

reservation, please feel free to replace the photo.  The General Tips section at the end of this document provides step-by-step 

instructions for replacing images. 

 

• Newspaper Template Post-Offer Event Announcement:  This document provides space for 

information about the name, date, time, and location of a post-offer outreach event.  The half-page 

announcement also provides space for the offer due date as well as the local BTFA agency name, and the 

Call Center contact information.   

 

There is space in the top left-hand corner of this template, as well as many of the toolkit items, for inclusion of the Tribal 

seal.  For all uses, please obtain proper authorization prior to use of the Tribal seal.  Some Tribes require Tribal council 

approval prior to use.  If the Tribe authorizes the use of their seal, copy and paste the image into the document and adjust 

the size accordingly.  To remove the note that says “Must receive approval to use crest/seal. If not approved use Buy-Back 

logo”, simply click note, and hit the delete button on the keyboard.  Consult the General Tips section at the end of this 

document for step-by-step instructions on inserting a Tribal seal and deleting the approval note.  The Buy-Back Program 

logo is provided in the template for use in place of the seal if desired or authorization is not obtained.  Included in the event is 

a stock photo that you are welcome to use. However, if you have a more relevant photo, such as one depicting land at the 

reservation, please feel free to replace the photo.  The General Tips section at the end of this document provides step-by-step 

instructions for replacing images. 
 

• Newspaper Template Post-Offer General:  This document is a half-page announcement that provides 

space for information reminding landowners of the offer due date, as well as the contact information for 

the Call Center, the Tribal outreach office, Federal and the local BTFA agency offices.   

 

There is space in the top left-hand corner of this template, as well as many of the toolkit items, for inclusion of the Tribal 
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seal.  For all uses, please obtain proper authorization prior to use of the Tribal seal.  Some Tribes require Tribal council 

approval prior to use.  If the Tribe authorizes the use of their seal, copy and paste the image into the document and adjust 

the size accordingly.  To remove the note that says “Must receive approval to use crest/seal. If not approved use Buy-Back 

logo”, simply click note, and hit the delete button on the keyboard.  Consult the General Tips section at the end of this 

document for step-by-step instructions on inserting a Tribal seal and deleting the approval note.  The Buy-Back Program 

logo is provided in the template for use in place of the seal if desired or authorization is not obtained.  Included in the event is 

a stock photo that you are welcome to use. However, if you have a more relevant photo, such as one depicting land at the 

reservation, please feel free to replace the photo.  The General Tips section at the end of this document provides step-by-step 

instructions for replacing images. 

 

• Poster-Template Post-Offer Tribe:  This document provides space for a reminder of the offer due 

date for landowners that choose to participate in the Program.  There is an example of the mailing 

envelope that the Program used to mail offers, so landowners recognize their offer.  The poster directs 

landowners with questions about the Program or about their offer to visit the Program’s website.  The 

poster also lists the phone number, email address, and location of the Tribal outreach office.    

 

There is space in the top left-hand corner of this template, as well as many of the toolkit items, for inclusion of the Tribal 

seal.  For all uses, please obtain proper authorization prior to use of the Tribal seal.  Some Tribes require Tribal council 

approval prior to use.  If the Tribe authorizes the use of their seal, copy and paste the image into the document and adjust 

the size accordingly.  To remove the note that says “Must receive approval to use crest/seal. If not approved use Buy-Back 

logo”, simply click note, and hit the delete button on the keyboard.  Consult the General Tips section at the end of this 

document for step-by-step instructions on inserting a Tribal seal and deleting the approval note.  The Buy-Back Program 

logo is provided in the template for use in place of the seal if desired or authorization is not obtained.  Included in the event is 

a stock photo that you are welcome to use. However, if you have a more relevant photo, such as one depicting land at the 

reservation, please feel free to replace the photo.  The General Tips section at the end of this document provides step-by-step 

instructions for replacing the background image of a document. 

  



 

Page 5 of 13 

 

General Tips 

• There is space in the document for inclusion of the Tribal seal.  For all uses, please obtain proper 

authorization prior to use of the Tribal seal. If the Tribe authorizes the use of their seal, copy and 

paste the image into the document and adjust the size accordingly.  If permission is not granted, 

please use the Land Buy-Back Program logo as an alternative. 

• Throughout the outreach materials there are placeholders that are identified with red text in between 

two brackets (e.g., <date>).  These are placeholders for any specific information that will need to be 

updated to align with the information that is trying to be communicated such as dates, Tribe names, 

phone numbers, event names, etc.  After you fill in the specific information, you can change the font 

color to black/auto on the home toolbar. 

Changing the generic background image on a template 

Select the background image, so the border controls are on the edge of the page as seen in the image on the 

left.  Press the delete key on your keyboard. The document should have a blank background.  
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1) On the Design tab, click Watermark.  

 

2) Click Picture, click Select Picture, browse through your image files, and then click the image that 

you want to use, and then click Insert.   

 

 

 

 

 

 

 

 

 

 

 

 

3) Adjust the scale of your image by modifying the scale options and clicking Apply.  If you want the 

background image to show with full color intensity, clear the Washout check box.  When you have 

finished customizing the image, click ok.  
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4) Your new background is set! 
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Removing the second page of the WAU ad 

1. Open the WAU ad template, add the list of WAU names to the table.  

2. If the second table is not needed, select the green border on the second page, and hit the delete key 

on your keyboard. 

 

 

 

 

 

 

 

 

 

 

 

3. Then select the text box, and hit the delete key on your keyboard.  

 

 

 

 

 

 

 

 

 

 

 

4. Repeat Step 3 

5. Finally, click on the blank page and hit the delete key on your keyboard to remove the unneeded 

second page.  

  



 

Page 9 of 13 

 

Removing the “Must receive approval to use crest/seal. If not approved use Buy-Back logo” note & 

adding a Tribal logo/seal 

1. To remove the “Must receive approval note…” click on the shape and hit the delete button on your 

keyboard. Then, to remove the red, Insert Tribal crest text, select the text box, and hit the delete 

button as shown below.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. To insert the saved Tribal seal, select the Insert tab, and then click pictures, as shown below.  
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3. Select the Image, and click insert.  

 

 

 

 

 

 

 

 

 

4. Select the Layout options box and click on with text wrapping as shown below, to move the image 

freely on the page.  

 

 

 

 

 

 

 

 

5. Once you have moved the image to the desired location, you have the option to keep the Program 

logo. If you would like to remove the image, simply select and delete as illustrated in step 1.  
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Changing an image 

1. Select the image you want to remove and hit the delete button on your keyboard. Repeat this step to 

remove the red text box as shown below.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. To insert the new image, select the Insert tab, and then click pictures, as shown below. 
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3. Select the image, and click Insert.  

 

 

 

 

 

 

 

 

 

 

4. If the Image is inserted on the wrong part of the page, select the Layout options box and click on 

with text wrapping as shown below, to move the image freely on the page. 
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5. After you have resized and moved the image to your desired location on the page, you are done.  


